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Baby Luigi has been kidnapped! Our adventure begins one sunny day

on Yoshi’s Island. Yoshi is out enjoying the day with a leisurely stroll

when, all of a sudden, two babies drop out of the sky. One of them

looks very familiar to Yoshi. With a forlorn look on his face, the baby

just gazes longingly at a mysterious castle that has appeared in the

sky. Yoshi wonders if the castle holds other babies.

Once again, it’s up to the Yoshi clan to save the day. This time, the

stork is coming with them too. 

A new journey begins. Can the Yoshis and babies triumph over

Kamek and save Baby Luigi?

StoryStoryStoryContentsContentsContents

In this instruction booklet, the top screen is framed in orange, and the Touch
Screen is framed in green. 
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Choose a File 
To start a new game, use the ✚ Control Pad to select
a file marked and press the A Button to confirm.
To continue a previous game, select a file containing
saved data. The Main Menu will appear next (see
page 8). Go back to the previous screen by pressing
the B Button.

Copy

Select to copy a saved game to an empty save file.
Select to return to the previous screen. 

Erase 

Select to erase saved data. Choose the file you want to
erase, and then select YES when the game asks you to
confirm. Be careful, because once saved data is erased,
it’s gone forever and can’t be restored.

Getting StartedGetting Started
Make sure that your Nintendo DS™ system is off. Insert the YOSHI’S ISLAND DS™
Game Card into the DS Game Card slot until it clicks into place and then turn
the power on.

Read the information on the Health and Safety 
Screen and then tap the Touch Screen to move to 
the Nintendo DS Menu Screen.

On the Nintendo DS Menu Screen, tap the 
YOSHI’S ISLAND DS Panel to start the game.

If you have set your Nintendo DS system to Auto Mode,
you can skip this step. See the instruction booklet of your
Nintendo DS system for more information.

The introductory cinema will start to play. To cancel out of
it, press START or the A Button, which will bring you to the
Title Screen. Press START or the A Button to move to the File Menu.

The in-game language depends on the one that is set on the console. In this
game you can choose between five different languages: English, German,
French, Spanish and Italian. If your Nintendo DS system is already set to one of
them, the same language will be displayed in the game. If your Nintendo DS
system is set to another language, the in-game default language will be English.
You can change the in-game language by changing the language setting of your
console. For further instructions about how to change language settings please
refer to the Nintendo DS Instruction Booklet.

Getting Started



OPTIONS
In the Options Menu, you can change the controls and sound. Move the
cursor over your selection and then press the A Button to confirm. Press the
B Button or to return to the Main Menu.

CONTROLS

Use the ✚ Control Pad to choose from the following
control schemes: , ,

, or . Press the A Button 
to confirm your selection.

SOUND

Choose from SURROUND, STEREO and HEADPHONES.
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Main Menu
Once the Main Menu appears on the Touch Screen,
make your selection with the ✚ Control Pad and then
confirm it by pressing the A Button. You can also
make your selection by tapping it.

ADVENTURE

Play as Yoshi and save the babies from the mysterious castle in the sky.

OPTIONS

Set the game controls and sounds.

Saving
Your game saves automatically after clearing a stage and changing game
settings. You can erase all saved files by holding down the A, B, X, Y, L and
R Buttons at the same time when starting the game, but please remember
that once saved files are erased, they can’t be recovered.

Use the A, B, X and Y Buttons to control.

Use the A, B, L and R Buttons to control.

PATIENT Press the A or R Button to aim an egg, 
and press it again to throw. 

HASTY Hold the A or R Button to aim an egg, 
and release to throw it.

8
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L Button

• Lock and release egg cursor

• Move screens up and down by holding

down the L Button and pressing Up and

Down on the ✚ Control Pad

✚ Control Pad

• Select menu items

• Up: Enter doors

• Hold Up: Look up

• Up + B Button: Enter overhead pipes

• Down: Crouch

• Down: Enter underfoot pipes

• Left and Right: Move and enter sideways

pipes

Y Button

• Stick out tongue (Swallow)

• Spit enemy when mouth is full

• Press Up on the ✚ Control Pad and the 

Y Button to stick tongue up

• Make an egg (Press Down on the 

✚ Control Pad after swallowing an enemy)

• Press Up on the ✚ Control Pad and 

the Y Button to throw an enemy upwards

X Button

• Same functions as for the L Button

R Button

• Display egg cursor -> Throw an egg (Press

Down on the ✚ Control Pad to cancel)

A Button

• Confirm

• Display egg cursor -> Throw an egg (Press

Down on the ✚ Control Pad to cancel)

B Button

• Cancel

• Jump

• Flutter Jump (Hold)

• Ground Pound (Press Down on the 

✚ Control Pad while jumping)

START

• Open the Pause Menu (see page 14)

You play this game by controlling Yoshi. Various babies ride on Yoshi’s back,
each giving him a special ability.

In the following section, black text indicates menu controls, while red text indicates
Yoshi’s controls. The explanations pertain to the control scheme.
Check your control scheme in the Controls tab of the Options Menu.

Press the L and R Buttons, START, and SELECT at the same time to reset the
game and start anew. Close the Nintendo DS system to activate Sleep Mode,
which will reduce battery consumption. Sleep Mode turns off when you open
the Nintendo DS system.

ControlsControlsControls

Y Button

X Button

R Button

A Button

B Button

START

SELECT

Top screen

L Button

✚ Control Pad

Touch Screen
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Map Screen
YOSHI’S ISLAND DS has five worlds, and each world features eight stages. 
Choose a stage with the ✚ Control Pad and press the A Button to enter it.

When you begin a new game, you play through a practice stage. After you clear
the practice stage, the Map Screen will appear.

Coin Count

(see page 16)

SCORE

MUSEUM

?

You will unlock this section

when you meet certain 

conditions.

Options

(see page 9)

This shows that you got 
the stage’s character coin.

Score
Total Score

Marks appear when you earn 

a certain number of points.

Remaining Lives

If you fail a course, you lose

one life (see page 14). If Yoshi

loses all his lives, your game

ends.

Worlds

Choose a world to play.

Stages

Choose a specific stage to play.

In Stages 4 and 8, you will

encounter a boss.

Stage SelectionStage SelectionStage Selection SCORE

Select SCORE on the Map Screen to check each stage’s score and character
coins collected (see page 16). The score appears on the scoreboard 
(see page 22) after completing a stage.

MUSEUM 

Select MUSEUM on the Map Screen to view the
enemies that you’ve hit with eggs. Enemies are
separated based on type, and many exhibits are
housed behind doors and through pipes. To return 
to the Map Screen, press START and select QUIT.



Pause Menu
Press START on the Action Screen to open the Pause Menu. From here,
you can choose to continue or return to the Map Screen by pressing the 
✚ Control Pad and then pressing the A Button to confirm. The Pause Menu
will also display your remaining lives and the items you’ve collected.
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Middle Ring
Partway through each stage is a ring of light called the Middle
Ring. Once you go through a Middle Ring, you can restart 
the stage from nearby if you fail before completing the stage.
What’s more, as you pass through it, your star power will
increase by ten.

Action Screen
Use a variety of actions as you
make your way through the
stages. Press Up or Down on 
the ✚ Control Pad while holding
down the X Button to scroll up
and down the screens.

Swallow, stomp, and throw eggs at enemies to defeat them. You lose a life if you
get crushed, if you touch spikes or lava, or if your star power reaches zero and
the baby is taken away by Toadies.

Playing the GamePlaying the GamePlaying the Game

Hold down the 

X Button and press

Up and Down on the

✚ Control Pad.

Star Power
When an enemy hits you and you take damage, the
baby falls off of Yoshi’s back. When this happens, 
the power of the stars will protect the baby for a short
while. A timer appears to show just how long this pro-
tection lasts. Try to get the baby back on Yoshi’s back
before time runs out! You can do this by making contact
with the baby. Once you retrieve the baby, the Star Power slowly increases back
up to ten. You can get more time by getting more stars (see page 16).

Stork Stop
You can switch the baby Yoshi is carrying by going to a Stork
Stop. When the stork comes by, jump up and grab the baby.
Each time you grab a baby, a different one will appear
overhead. 

Star Power



Minigames
When you find a key and enter a
locked door, a minigame will begin.
There are several types of minigames.
Depending on how well you play, you
can win extra lives.
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Items Switches and Things

They are scattered throughout
the stages. Collect 100 coins to
get a 1-Up.

Coins

Each stage has 20 of them. They
also get added to your coin
count. Red Coins also affect your
chance of unlocking a Bonus
Challenge (see page 23).

Red Coins

Throw them to defeat enemies,
move objects, and grab items.

Green Eggs

Throw them at enemies. You
receive two coins if you make
contact.

Yellow Eggs

Throw them at enemies. You
receive two stars if you make
contact. You can also get coins
with it.

Red Eggs

Hit them from below to get
helpful hints.

Message Blocks

Step on these to reveal hidden
objects and cause other special
things to happen.

Switches

When you hit these with eggs,
stars or coins will pop out. Or
something else might happen...

Winged Clouds

You can open locked doors if you
have a key.

Keys and Doors

Collect five in each stage to
receive a 1-Up. Flowers also
affect your score and your
chance of unlocking a Bonus
Challenge.

Flowers

Each star increases your Star
Power by one, with a maximum
of 30. Stars also affect your
chance of unlocking a Bonus
Challenge.

Stars

You can collect these when the
baby Yoshi is carrying matches
the baby on the coin. A nice sur-
prise awaits you when you collect
them all!

Character Coins



1918

Baby Mario
Press the Y Button while walking to dash, which 
lets Yoshi move faster than he normally does. Jump
while dashing to jump farther. Baby Wario

With his magnet, Baby Wario automatically attracts
metal (including coins) around Yoshi. Press Up on
the ✚ Control Pad or jump to attract things above
Yoshi. 

Yoshi’s abilities change depending on the baby on his back. Switch babies at
Stork Stops (see page 15).

Baby Peach
Baby Peach lets Yoshi Flutter-Jump longer than
any other baby, and also lets him fly farther. Catch
the wind while Flutter-Jumping to fly across large
distances.

Special
Ability Dashing

Special
Ability Floating

Baby DK
Grab and swing on vines and ropes. Jump to let go.
Press the Y Button while pressing Down on the 
✚ Control Pad to charge at enemies and smash walls.

Special
Ability Attracting Metal

Special
Abilities Climbing, Swinging, Baby DK Dash Attack

Baby AbilitiesBaby AbilitiesBaby Abilities

Baby Bowser
With his fiery breath, Baby Bowser can defeat
enemies and melt ice. Breathe fire by pressing the 
Y Button. Keep in mind that Yoshi can’t make eggs

with Baby Bowser on his back, but 
he can still pick them up and throw
them.

Special
Ability Breathing Fire
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Super Stars and Superstar Mario
If Yoshi finds a Super Star when Baby Mario is on his back,
Baby Mario will power up and become invincible for a
while. The controls change when you control Baby Mario.

Morph Yoshi
Touch a morph bubble to cause Yoshi 
to transform briefly into the item in the
bubble. Control him with the ✚ Control
Pad. Morphed Yoshi goes back to his
normal state after a while or when you
touch the Yoshi Block.

Vehicles
Control both the kangaroo and stilts by hopping on them and then using the
✚ Control Pad. Hop off the kangaroo when it reaches a certain point, and jump
off the stilts at any time. The cart moves on its own, so just jump on and off it.

In addition to the abilities already mentioned, Yoshi can morph into different
items and hop on different vehicles.

Yoshi’s AbilitiesYoshi’s AbilitiesYoshi’s Abilities

Super Star

Dash
Press the Y Button while wal-
king to run really fast.

Climb Walls
Press Left or Right on the 
✚ Control Pad to climb walls.

Float
Hold down the B Button after
jumping for a gentle landing.

Helicopter Mole Tank Submarine

Yoshi BlockMorph Bubble

Kangaroo Stilts Cart



Bonus Challenges
On the goal roulette, there is one flower space for every flower you found 
in this stage. If the roulette stops on a flower space, you get to play a Bonus
Challenge where you could win 1-Ups. 

2322

Goal Roulette
When you reach the goal, the goal roulette appears. You clear
the stage when Yoshi passes through it, and then the score-
board will appear.

Scoreboard
The scoreboard appears when you clear a stage. Press the A Button to return to
the Map Screen.

Scratch and Match

Rub off any three spots. You receive 1-Ups based on
how many Baby Mario faces you reveal.

Match Cards

Flip over cards one at a time and match them in pairs.
Each matching pair wins you a 1-Up. You can play
until you miss twice or until all the cards are revealed.

Slot Machine

Press the A Button to stop the drum. If the pictures
match in the middle row, you receive one or more 
1-Ups.

You clear the stage when you pass through the goal roulette. Once you clear a
stage, you can play it again as many times as you like.

The Goal and your Score The Goal and your Score The Goal and your Score 

Current Score

Total World Score

HIGH SCORE

Star Power At Goal, 
Red Coins, Flowers

Each Stage’s Score
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Look Around!
When you want to know what’s in the area above or below you, press Up or
Down on the ✚ Control Pad while holding down the X Button.

Pick the Right Baby!
Yoshi’s abilities change depending on which baby he’s
carrying. If you’re stuck in a stage, look for a Stork Stop to
switch the babies, and then give it another try.

Eggs Are Your Friends!
If you drop a baby after bumping into an enemy or taking
damage, throw an egg at the baby to move him closer to
the ground. Get the baby before he wanders away! You can
carry up to six eggs at once.

To clear the entire game, you’ll need to master all of Yoshi’s and the babies’ skills.

TipsTipsTips






